BD OneFlow™ LST

20 tests per kit—Catalog No. 658619
CONTENTS

1. INTENDED USE ............................................................................ 5
2. SUMMARY AND EXPLANATION ................................................ 5
3. PRINCIPLES OF THE PROCEDURE.............................................. 6
4. REAGENT COMPOSITION.......................................................... 6
5. STORAGE AND HANDLING....................................................... 8
6. REAGENTS OR MATERIALS REQUIRED BUT NOT PROVIDED.... 9
7. INSTRUMENTS........................................................................... 10
8. SPECIMENS ............................................................................ 10
9. PROCEDURE .............................................................................. 11
   Installing the OneFlow LST Template ........................................ 11
   Setting up the Cytometer ............................................................ 12
   Washing the Specimen ............................................................... 13
   Diluting BD FACS Lysing Solution ............................................. 13
   Staining the Specimen ............................................................... 14
   Setting up the Experiment .......................................................... 15
   Acquiring the Stained Sample .................................................... 18
   Analyzing the Data Using BD FACSDiva Software ..................... 19
10. PERFORMANCE CHARACTERISTICS........................................ 22
    Reproducibility ......................................................................... 22
    Repeatability ............................................................................ 23
    Method Comparison .................................................................. 24
    Equivalency .............................................................................. 28
1. INTENDED USE
The BD OneFlow™ LST (Lymphoid Screening Tube) is intended for flow-cytometric immunophenotyping of normal and aberrant mature lymphocyte populations of B, T, and NK lineages in peripheral blood, bone marrow, and lymph nodes, as an aid in the diagnosis of hematological disorders. The BD OneFlow LST is designed for use with a suitably equipped BD flow cytometer and software designated for in vitro diagnostic use.

2. SUMMARY AND EXPLANATION
In chronic lymphoproliferative disorders (CLPD), clonogenic events lead to the expansion and accumulation of mature-appearing lymphocytes, which carry a proliferative and/or survival advantage over their normal counterparts. Thus, the detection of phenotypically aberrant and clonal mature lymphocytes is critical to the diagnosis of CLPD.

The EuroFlow™ Consortium designed multicolor antibody panels to fully characterize the cell populations in a patient specimen using immunophenotypic markers that are indicative of normal and abnormal cells. In addition to the optimized multicolor antibody panels, the EuroFlow protocol comprises standardized procedures for cytometer setup, determination of assay settings, sample preparation and staining, sample acquisition, and data analysis.

The single-tube screening panels and multi-tube classification panels fit into the EuroFlow diagnostic algorithm for the identification and classification of hematological disorders. Each tube contains a set of backbone markers and a set of classification markers. Backbone markers are shared across a particular set of panels and are used to normalize the samples so that data files can be combined and analyzed.

* The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property of the EuroFlow Consortium and cannot be reproduced or published without prior written permission from the EuroFlow coordinator (www.euroflow.org).
as a single large data file. They are markers that identify distinct cell populations in a particular cell lineage. Classification markers have been selected for their diagnostic utility in discriminating between cell types within a given lineage and in classifying the abnormal cell type in the sample.

3. PRINCIPLES OF THE PROCEDURE

Multiparameter flow cytometry is a sensitive and rapid tool for the qualitative and quantitative characterization of cell populations in a specimen. Cells are incubated with fluorochrome-conjugated antibodies which bind to their target molecules. The stained cells can then be analyzed on a single-cell basis. Multiparameter analysis of the data is used to identify the cell populations in the patient specimen and can lead to the identification of an aberrant clonal cell population.

The number of parameters used in flow cytometric immunophenotyping of hematological disorders has increased in recent years. BD OneFlow LST contains a panel of fluorochrome-conjugated antibodies that identify normal and aberrant populations of B, T, and NK lymphocytes, and the data files generated are analyzed using BD FACSDiva™ software. Analysis of the dot plots allows for the identification of normal and abnormal cell populations.

4. REAGENT COMPOSITION

BD OneFlow LST consists of single-use tubes containing the following fluorochrome-conjugated antibodies in an optimized dried formulation. See Table 1.
The antibodies in BD OneFlow LST were chosen for their ability to separate normal lymphocytes into their major subpopulations. CD45 identifies mature lymphocytes and B-cell precursors. CD3 identifies T cells. CD3 can also be used to identify B cells and NK cells by exclusion.

<table>
<thead>
<tr>
<th>Antibody</th>
<th>Fluorochrome</th>
<th>Clone</th>
<th>Isotype</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD8</td>
<td>FITC</td>
<td>SK1 (Leu2a)</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>Anti-Lambda</td>
<td>FITC</td>
<td>1-155-2*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>CD56</td>
<td>PE</td>
<td>MY31 (Leu-19)</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>Anti-Kappa</td>
<td>PE</td>
<td>TB28-2*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>CD5</td>
<td>PerCP-Cy5.5</td>
<td>L17F12*</td>
<td>IgG2a, κ</td>
</tr>
<tr>
<td>CD19</td>
<td>PE-Cy7*</td>
<td>SJ25-C1*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>Anti-TCRγδ-1</td>
<td>PE-Cy7</td>
<td>11F2*</td>
<td>IgG3, κ</td>
</tr>
<tr>
<td>CD3</td>
<td>APC</td>
<td>SK7*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>CD38</td>
<td>APC-H7*</td>
<td>HB7*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>CD4</td>
<td>V450®</td>
<td>SK1 (Leu3a)*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>CD20</td>
<td>V450®</td>
<td>L27*</td>
<td>IgG1, κ</td>
</tr>
<tr>
<td>CD45</td>
<td>V500-C®</td>
<td>2D1*</td>
<td>IgG1, κ</td>
</tr>
</tbody>
</table>

a. Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare and Carnegie Mellon University, and is made and sold under license from GE Healthcare. This product is licensed for sale only for in vitro diagnostics. It is not licensed for any other use. If you require any additional license to use this product and do not have one, return this material, unopened, to BD Biosciences, 2350 Qume Drive, San Jose, CA 95131, and any money paid for the material will be refunded.

b. BD Horizon™ V450, BD Horizon™ V500 C
Anti-TCRγδ-1, CD5, CD4, and CD8 can separate T cells into a number of subpopulations.

CD19 and CD20 identify B cells, and together with CD45 can separate B cells into mature B lymphocytes (CD19+, CD20hi, CD45hi) and B-cell precursors (CD19+, CD20lo, CD45lo). CD19 and CD20 are also used to identify NK cells by exclusion.

Anti-Kappa and Anti-Lambda can identify normal and clonally expanded populations of B cells expressing Igκ or Igλ on the surface membrane, respectively.

CD38 identifies plasma cells and B-cell precursors. In addition, it is informative in the evaluation of a wide variety of lymphoid malignancies. CD38 can also aid in the identification of NK cells.

CD56 identifies NK cells.

Refer to the article describing the EuroFlow antibody panels for a full description of the utility of the antibodies chosen for BD OneFlow LST.

5. STORAGE AND HANDLING

Store tubes at 2°C–27°C in the foil pouch. Do not freeze the reagent or expose it to direct light at any time during storage or incubation with cells. The dried fluorochrome-conjugated antibodies are stable until the expiration date shown on the pouch and tube labels when stored as directed. Do not use after the expiration date. Once the pouch is opened, the dried fluorochrome-conjugated antibodies are stable for one month when stored as directed.

CAUTION Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to moisture. Do not remove the desiccant from the reagent pouch.
6. REAGENTS OR MATERIALS REQUIRED BUT NOT PROVIDED

- Templates installer CD for BD OneFlow™ Assays (Catalog No. 659305)

The OneFlow LST template is provided on an installer CD. The template contains two global worksheets: the BD OneFlow LST Acquisition worksheet and the BD OneFlow LST Analysis worksheet. Unless you already have the current OneFlow LST template, you will have to order the installer CD the first time you order BD OneFlow LST. The installer CD also contains the OneFlow Setup template and templates for other BD OneFlow™ reagents.

The Instrument Setup Guide for BD OneFlow™ Assays and the BD OneFlow™ LST Application Guide are provided on separate CDs along with the installer CD. The Application Guides for BD OneFlow™ Assays CD also contains application guides for other BD OneFlow reagents.

- 15-mL conical polypropylene tubes
- Pasteur pipet
- Serological pipet
- Micropipettor with tips
- Vortex mixer
- Wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium azide)
- BD FACSTM lysing solution (10X) (Catalog No. 349202)

See the BD FACSTM Lysing Solution instructions for use (IFU) for precautions and warnings.

- Centrifuge
- BD FACSDiva™ CS&T IVD beads (Catalog No. 656046 or 656047)
– BD OneFlow™ Setup Beads (Catalog No. 658620)
– BD™ FC Beads 8-color kit for BD OneFlow™ Assays
  (BD FC Beads) (Catalog No. 658621)

7. INSTRUMENTS
BD OneFlow LST is for use on a BD FACSCanto™ II flow cytometer
with a 3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical
configuration, running BD FACSDiva software v8.0.1 or later.

8. SPECIMENS
BD OneFlow LST can be used for immunophenotyping by flow
cytometry of peripheral blood (PB) or bone marrow (BM) aspirates
collected in EDTA or heparin (for example, BD Vacutainer® tubes),
and fresh lymph nodes (LN) collected in PBS or cell culture media, such
as RPMI. Each type of specimen can have different storage conditions
and limitations that should be considered prior to collection and
analysis.15,16,21

NOTE  Use of heparin as an anticoagulant can result in dimmer
staining for CD56 compared to staining when using EDTA.
Specimens should be processed immediately after collection. If a longer
period of time is desired, each laboratory should validate that
specimens processed and stored according to their procedures produce
equivalent results to specimens processed immediately after collection.
PB17,18,23 and BM22,23 specimens collected in anticoagulants may be
stored at room temperature for up to 24 hours before testing.
Specimens with large numbers of nonviable cells can give erroneous
results due to selective loss of populations and to increased nonspecific
binding of antibodies to nonviable cells. Viability of specimens should
be assessed and a cutoff value established. A cutoff value of at least
80% viable cells has been suggested.15
Specimens should be acquired immediately after staining. If a longer period of time is desired, each laboratory should validate that stained specimens acquired after being held under their storage conditions produce equivalent results to specimens acquired immediately after staining. Protect stained specimens from light until they are acquired. 

**WARNING** All biological specimens and materials coming in contact with them are considered biohazards. Handle as if capable of transmitting infection¹⁹,²⁰ and dispose of with proper precautions in accordance with federal, state, and local regulations. Never pipette by mouth. Wear suitable protective clothing, eyewear, and gloves.

9. **PROCEDURE**

**Installing the OneFlow LST Template**

The OneFlow LST template has to be installed before you run the assay for the first time. Additional templates can be installed at the same time, as needed. If you will analyze the FCS files on a different workstation from the one used to acquire the samples, ensure that you install the templates on both workstations.

**NOTE** When you select a template to install, it will always overwrite any template with the same name that was previously installed on the system. If you do not want an existing template on your computer to be overwritten, do not select that template from the installer during the installation process.

1. Insert the installer CD and click the installer icon.

**NOTE** If the installer does not start automatically, access it through the CD drive and open it.
2. Follow the instructions in the dialog.
   The installer will copy and paste the templates in the folder "D:\BDExport\Templates\Panel\BD Panels."
   **NOTE** If your system has only one drive, the templates will be installed in "C:\BDExport\Templates\Panel\BD Panels."
   After installation is complete, a dialog opens, summarizing which templates have been successfully copied into the folder.

3. Click **OK** to close the dialog.
4. The installer ReadMe file opens. Click the close box when you have finished reading it.
5. Eject the installer CD.

**Setting up the Cytometer**

1. Use BD FACSDiva CS&T IVD beads (CS&T IVD beads) and BD FACSDiva software v8.0.1 or later, to define the baseline of the cytometer and to run a daily performance check of the cytometer. See the **BD FACSDiva™ CS&T IVD Beads IFU** and the **Instrument Setup Guide for BD OneFlow™ Assays** for more information.

2. Use BD OneFlow Setup beads, lysed washed blood, and BD FACSDiva software v8.0.1 or later, to set photomultiplier tube (PMT) and scatter voltages monthly. See the **BD OneFlow™ Setup Beads IFU** and the **Instrument Setup Guide for BD OneFlow™ Assays** for more information.

3. Use BD FC Beads and BD FACSDiva software v8.0.1 or later, to set fluorescence compensation monthly. See the **BD™ FC Beads 8-color kit for BD OneFlow™ Assays IFU** and the **Instrument Setup Guide for BD OneFlow™ Assays** for more information.
Washing the Specimen

**NOTE** Before washing the specimen, confirm that the cytometer has been properly set up. We recommend that you confirm that the PMT voltages (PMTVs) are still within their daily target ranges. See the chapter for daily setup in the *Instrument Setup Guide for BD OneFlow™ Assays* for more information.

1. Label a 15-mL conical tube with the specimen ID.
2. Invert the specimen in the collection tube 10 times to mix well.
3. Add 300 µL of the specimen to the labeled conical tube.
4. Add 10 mL of wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium azide).
5. Invert the tube 3–5 times to mix well.
6. Centrifuge at 540g for 5 minutes at 20°C–25°C.
7. Remove the supernatant without disturbing the cell pellet.
8. Vortex the tube until no cell aggregates remain before adding wash buffer.
9. Repeat steps 4–8 twice for a total of three washes.
10. Resuspend the cell pellet in 200 µL of wash buffer to give a final volume of approximately 300 µL.

**NOTE** Start staining the specimen using BD OneFlow LST within 30 minutes of the last wash. Store the washed specimen at 20°C–25°C until you stain it.

Diluting BD FACS Lysing Solution

Dilute the 10X concentrate 1:10 with room temperature (20°C–25°C) deionized water. The prepared solution is stable for 1 month when stored in a glass or high density polyethylene (HDPE) container at room temperature.
Staining the Specimen

1. If the pouch is stored refrigerated, allow it to reach room temperature before opening it.
   **NOTE** The reagent is very sensitive to moisture. To avoid condensation, open the pouch only if it is at room temperature.

2. For each patient specimen, remove a BD OneFlow LST tube from the pouch.

3. Place the tubes in a rack, protected from light.

4. Immediately reseal the pouch with any unused tubes.
   **NOTE** Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to moisture. Do not remove the desiccant from the reagent pouch.

5. Write the patient ID on the BD OneFlow LST tube label within the area provided.
   **NOTE** Write the current date on the pouch label when it is first opened. Use the tubes from that pouch within one month before opening the next pouch.

6. Vortex washed specimen 3–5 seconds to mix well.

7. Add 100 µL of washed specimen to the tube. Vortex vigorously 3–5 seconds to mix well.
   If less than 100 µL of specimen is used, add wash buffer to a final volume of 100 µL.
   **NOTE** Staining from $3 \times 10^4$ to $4 \times 10^6$ white blood cells gives equivalent results.
   **NOTE** Do not wipe the outside of the tube with ethanol or isopropanol because the ink on the printed label can run.

8. Incubate for 30 minutes at 20°C–25°C, protected from light.
9. Add 2 mL of 1X BD FACS lysing solution. Vortex 3–5 seconds to mix well.
10. Incubate for 10 minutes at 20°C–25°C, protected from light.
11. Centrifuge at 540g for 5 minutes at 20°C–25°C.
12. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 µL of residual liquid in the tube.
13. Vortex vigorously until the cell pellet is completely resuspended.
14. Add 2 mL of wash buffer to the tube. Vortex 3–5 seconds to mix well.
15. Centrifuge at 540g for 5 minutes at 20°C–25°C.
16. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 µL of residual liquid in the tube.
17. Vortex 3–5 seconds to resuspend the cell pellet.
18. Add 200 µL of wash buffer to the tube. Vortex 3–5 seconds to mix well.

**NOTE** Specimens should be acquired immediately after staining. If a longer period of time is desired, each laboratory should validate that stained specimens acquired after being held under their storage conditions produce equivalent results to specimens acquired immediately after staining. Protect stained specimens from light until they are acquired.

**Setting up the Experiment**

1. From the menu bar, select Edit > User Preferences, then navigate to the FCS tab, and select Export FCS after recording, to automatically export the FCS files after acquisition. Click OK.
2. Confirm that the cytometer is in the default 4-2H-2V configuration.
3. From the menu bar, select Experiment > New Experiment > Blank Experiment. Click OK.
   NOTE You can also create an experiment directly from the Browser using the Experiment icon.

4. If prompted by the CST Mismatch window, select Use CST Settings.

5. Rename the experiment according to your laboratory practice.

6. In the Browser, right-click Cytometer Settings > Link Setup and select the appropriate compensation matrix calculated using BD FC Beads within the past 31 days. Click Link.
   See the BD™ FC Beads 8-color kit for BD OneFlow™ Assays IFU or the Instrument Setup Guide for BD OneFlow™ Assays.

7. If prompted by the Cytometer Settings Mismatch window, select Overwrite.

8. Right-click Cytometer Settings > Unlink From the previously linked compensation setup. Click OK.
   NOTE Unlinking the compensation setup allows updated application settings to be applied while retaining compensation values.

9. In the Browser, right-click Cytometer Settings > Application Settings > Apply and select the most recent application settings determined within the last 31 days using the BD OneFlow Setup beads. Click Apply.

10. A Confirm dialog opens. Select Keep the compensation value.

11. If prompted by the Confirm Cytometer Changes dialog, click Yes to overwrite the cytometer values for FSC Area Scaling.

12. From the menu bar, select Experiment > New Specimen.
   The Panel Templates dialog opens.
13. Navigate to the **BD Panels** tab and select the OneFlow LST template.

14. Indicate the number of patient specimens you want to acquire using the *Copies* field near the bottom of the **BD Panels** tab. Click **OK**.

15. Rename each specimen, for example, with the appropriate patient ID in front of the specimen name.

   **NOTE** If you have to re-run a particular patient sample, set the current tube pointer to the OneFlow LST tube you wish to re-run. Click the **Next Tube** button in the **Acquisition Dashboard** to create another tube for that patient. Do not use the new tube icon to create the additional tube to be acquired because the labels and barcode fields will not be populated.

   **NOTE** If you want to acquire additional patient samples stained with BD OneFlow LST in the experiment, repeat steps 12–15 to add new specimens. Two **Confirm** dialogs will open asking if you want to create another LST acquisition worksheet or another LST analysis worksheet. Click **Cancel** in each dialog.

16. From the menu bar, select **Experiment > Experiment Layout** and navigate to the **Keywords** tab.

17. Highlight the **Product ID** keyword for the appropriate tube, and scan the barcode on the BD OneFlow LST tube label.

   **NOTE** If you cannot scan the barcode on the tube label, see **Troubleshooting**.

18. Manually add the appropriate information to the remaining keywords, as needed.

19. Click **OK** to close the **Experiment Layout**.
Acquiring the Stained Sample

1. In the **Browser**, expand the appropriate specimen and set the current tube pointer to that tube.
2. Select the **BD OneFlow LST Acquisition** worksheet tab.
3. Vortex the stained tube 3–5 seconds at low speed.
4. Install the tube on the cytometer. Adjust the flow rate to **Medium** in the **Acquisition Dashboard**. Click **Acquire Data**.
5. Verify that the population is on scale and adjust the gate in the first plot of the LST acquisition worksheet to exclude debris, if needed.
6. Click **Record Data** in the **Acquisition Dashboard** to collect total events.
   
   **NOTE** The template will automatically collect 100,000 total events. Use the menu in the **Acquisition Dashboard** to select a different number of events to acquire, if needed. Collecting total events from $3 \times 10^4$ to $4 \times 10^6$ stained cells gives equivalent results.
7. Inspect the dot plots on the LST acquisition worksheet and adjust the gates as needed.
   
   The FSC-A vs SSC-A dot plot is used to identify cells.
   The CD45 V500-A vs SSC-A dot plot contains two gates to identify leukocytes and lymphocytes. T cells and B cells are identified in the CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot from the lymphocyte population.
   T cells are divided into TCRγδ+ and TCRγδ- populations in the CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot from the T-cell population. TCRγδ- cells are divided into CD8+CD4- and
CD4+CD8- populations in the CD20+CD4 V450-A vs CD8+IgL FITC-A dot plot.

Igκ- and Igλ-expressing B cells are identified in the CD56+IgK PE-A vs CD8+Igl FITC-A dot plot from the B-cell population.

NK cells are identified from the NOT(T cells OR B cells) population in the CD45 V500-A vs CD56+IgK PE-A dot plot.

The remaining dot plots do not contain gates and are included to ensure that the antibodies can stain cells in the specimen, therefore serving as an internal quality control for the tube.

NOTE See the BD OneFlow™ LST Application Guide for examples of the dot plots showing populations of normal cells in the LST acquisition worksheet.

8. Acquire the next sample.

9. From the menu bar, select File > Export > Experiments, and select the Directory Export option. Click OK.

Analyzing the Data Using BD FACSDiva Software

1. From the menu bar, select File > Import > Experiments.

2. Select the experiment that you want to analyze. Click Import.

   The experiment with the associated acquisition and analysis worksheets opens.

3. Select the BD OneFlow LST Analysis worksheet tab.
4. Inspect the dot plots on page 1 of the LST analysis worksheet and adjust the gates as needed.

**NOTE** Enlarge the dot plot while adjusting the gates so you can more readily see the populations of interest.

The first three dot plots on the LST analysis worksheet identify cells, FSC singlets, and SSC singlets. Debris and doublets are excluded by adjusting the gates.

Examine the leukocyte and lymphocyte populations in the CD45 V500-A vs SSC-A dot plot.

Examine the B-cell and T-cell populations in the CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot from the lymphocyte population. Examine the TCRγδ+ and TCRγδ- populations in the CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot from the T-cell population. The CD38 APC-H7-A vs SSC-A dot plot is included for informational purposes to allow for the visualization of CD38+ cells.

**NOTE** See the BD OneFlow™ LST Application Guide for examples of dot plots showing populations of normal cells.

5. Inspect the dot plots on page 2 of the LST analysis worksheet and adjust the gates as needed.

The dot plots on page 2 of the analysis worksheet identify various populations of T cells. TCRγδ- T cells are divided into CD8+CD4-, CD4+CD8-, CD4+CD8+, and CD4-CD8- populations in the CD20+CD4 V450-A vs CD8+IgM FITC-A dot plot.

The remaining dot plots further characterize TCRγδ- and TCRγδ+ cells using various markers.
6. Inspect the dot plots on page 3 of the LST analysis worksheet and adjust the gates as needed.

   The dot plots on page 3 of the analysis worksheet identify B cells. B cells are initially identified as being CD3⁻CD19⁺CD45⁺. Examine the level of CD20 expression in the CD19+TCRgd PE-Cy7-A vs CD20+CD4 V450-A dot plot.

   Examine the ratio of Igκ- to Igλ-expressing B cells in the CD56⁺IgK PE-A vs CD8⁺IgL FITC-A dot plot.

   The remaining dot plots further characterize B cells using various markers.

7. Inspect the dot plots on page 4 of the LST analysis worksheet and adjust the gates as needed.

   The dot plots on page 4 of the analysis worksheet identify NK cells. NK cells are identified from the NOT(T cells OR B cells) population in the CD45 V500-A vs CD56⁺IgK PE-A dot plot.

   The remaining dot plots further characterize NK cells using various markers.

8. Examine the results in the statistics box on page 5 of the LST analysis worksheet.

   Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see Troubleshooting.

9. Perform further analyses as needed.

    **NOTE** The gates in the dot plots of the LST analysis worksheet are provided for analyzing normal and aberrant cell populations in the specimen.

10. Save the LST analysis worksheet as a PDF.

    **NOTE** The analysis worksheet is a global worksheet. Any gates that are adjusted when analyzing a sample on a global worksheet...
will be changed in previously analyzed files. Previously saved PDFs
won’t change, but if you go back to a previously analyzed global
worksheet, you will have to readjust the gates so they match what
they were before.
11. (Optional) Click **Print** to print the LST analysis worksheet.
12. Analyze the next sample.

10. PERFORMANCE CHARACTERISTICS
    Precision studies for the reproducibility and repeatability of the
    BD OneFlow LST were performed at BD Biosciences laboratories in San
    Jose, CA.
    
    **Reproducibility**
    Two operators performed two separate runs per day over a period of
eight days, alternating the runs on two BD FACSCanto II flow
cytometers. For each run, duplicate samples of BD™ Multi-Check
control were stained using three lots of BD OneFlow LST by each
operator, and then acquired and analyzed using the OneFlow LST
template in BD FACSDiva software. Nine cell populations were
identified as being a percentage of the cell populations indicated in
Table 2. The reproducibility of the subset percentages was calculated
for each cell population. Reproducibility comprises four components:
operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and
day-to-day reproducibility.
Repeatability

Two operators performed two separate runs per day over a period of eight days, alternating the runs on two BD FACSCanto II flow cytometers. For each run, duplicate samples of BD Multi-Check control were stained using three lots of BD OneFlow LST by each operator, and then acquired and analyzed using the OneFlow LST template in BD FACSDiva software. Nine cell populations were identified as being a percentage of the cell populations indicated in Table 3. The within-run precision (tube-to-tube repeatability) of the subset percentages was calculated for each of the cell populations.

Table 2 Reproducibility of subset percentages

<table>
<thead>
<tr>
<th>Population</th>
<th>Mean</th>
<th>SD</th>
<th>$\text{Upper 95}%, CL$ of SD</th>
<th>$%CV$</th>
<th>$\text{Upper 95}%, CL$ of $%CV$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leukocytes (%SSC Singlets)</td>
<td>100.0</td>
<td>0.01</td>
<td>0.03</td>
<td>0.01</td>
<td>0.03</td>
</tr>
<tr>
<td>Lymphocytes (%Leukocytes)</td>
<td>37.9</td>
<td>0.5</td>
<td>1.1</td>
<td>1.2</td>
<td>2.9</td>
</tr>
<tr>
<td>T cells (%Lymphocytes)</td>
<td>70.3</td>
<td>0.2</td>
<td>0.3</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>CD4+CD8– cells (%T cells)</td>
<td>63.4</td>
<td>0.5</td>
<td>1.5</td>
<td>0.8</td>
<td>2.4</td>
</tr>
<tr>
<td>CD8+CD4– cells (%T cells)</td>
<td>25.1</td>
<td>1.1</td>
<td>3.2</td>
<td>4.4</td>
<td>12.8</td>
</tr>
<tr>
<td>B cells (%Lymphocytes)</td>
<td>14.8</td>
<td>0.2</td>
<td>1.0</td>
<td>1.5</td>
<td>6.5</td>
</tr>
<tr>
<td>NK cells (%Lymphocytes)</td>
<td>14.8</td>
<td>0.3</td>
<td>0.8</td>
<td>1.9</td>
<td>5.6</td>
</tr>
<tr>
<td>smIgκ cells (%B cells)</td>
<td>59.4</td>
<td>0.2</td>
<td>3.1</td>
<td>0.3</td>
<td>5.2</td>
</tr>
<tr>
<td>smIgλcells (%B cells)</td>
<td>40.6</td>
<td>0.2</td>
<td>2.8</td>
<td>0.4</td>
<td>6.8</td>
</tr>
</tbody>
</table>

a. SD = Standard deviation  
b. CL = Confidence limit  
c. %CV = Coefficient of variation
Method Comparison

A side-by-side comparison study between the BD OneFlow LST system on the BD FACSCanto II flow cytometer and the EuroFlow LST system on the BD FACSCanto II flow cytometer was performed at 3 external clinical sites. The BD OneFlow LST system comprises BD OneFlow Setup Beads, BD FC Beads for compensation, and the BD OneFlow LST reagent. The EuroFlow LST reference system comprises Sphero™† Rainbow calibration particles (8 peaks), single color stained cells plus BD™ Multicolor CompBeads for compensation, and the EuroFlow LST reagent cocktail. Both methods used BD FACSDiva CS&T IVD beads to perform instrument quality control. Abnormal mature lymphocyte populations from 81 patients with B-cell malignancies, 35 patients with T-cell malignancies, and 6 patients with NK-cell malignancies were identified using the two systems, and

<table>
<thead>
<tr>
<th>Population</th>
<th>Mean</th>
<th>SD</th>
<th>Upper 95% CL of SD</th>
<th>%CV</th>
<th>Upper 95% CL of %CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leukocytes (%SSC Singlets)</td>
<td>100.0</td>
<td>0.03</td>
<td>0.03</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>Lymphocytes (%Leukocytes)</td>
<td>37.9</td>
<td>0.5</td>
<td>0.5</td>
<td>1.3</td>
<td>1.4</td>
</tr>
<tr>
<td>T cells (%Lymphocytes)</td>
<td>70.3</td>
<td>0.4</td>
<td>0.4</td>
<td>0.5</td>
<td>0.6</td>
</tr>
<tr>
<td>CD4+CD8– cells (%T cells)</td>
<td>63.4</td>
<td>0.5</td>
<td>0.6</td>
<td>0.8</td>
<td>0.9</td>
</tr>
<tr>
<td>CD8+CD4– cells (%T cells)</td>
<td>25.1</td>
<td>0.7</td>
<td>0.8</td>
<td>3.0</td>
<td>3.2</td>
</tr>
<tr>
<td>B cells (%Lymphocytes)</td>
<td>14.8</td>
<td>0.3</td>
<td>0.3</td>
<td>1.8</td>
<td>2.0</td>
</tr>
<tr>
<td>NK cells (%Lymphocytes)</td>
<td>14.8</td>
<td>0.3</td>
<td>0.3</td>
<td>2.1</td>
<td>2.3</td>
</tr>
<tr>
<td>smIgκ+ cells (%B cells)</td>
<td>59.4</td>
<td>0.8</td>
<td>0.8</td>
<td>1.3</td>
<td>1.4</td>
</tr>
<tr>
<td>smIgλ+ cells (%B cells)</td>
<td>40.6</td>
<td>0.8</td>
<td>0.8</td>
<td>1.9</td>
<td>2.1</td>
</tr>
</tbody>
</table>

† Sphero is a trademark of Spherotech, Inc.
compared. In addition, 9 samples were identified as being from other lineages, for example, plasma cell disorders or bi-phenotypic samples. Cell populations from 76 negative samples, including 19 healthy donors, were identified using the two systems. A total of 123 PB specimens, 53 BM specimens, and 31 fresh LN specimens were enrolled in the study. PB and BM specimens were stained within 24 hours of collection. LN specimens were stained within 6 hours of collection. All stained samples were acquired within 1 hour of staining. Samples were identified as being “Follow-up needed” or “No follow-up needed” using the two systems, and compared. Agreement was calculated as follows:

Overall % agreement = \((\frac{a+d}{a+b+c+d})\times100\)

wherein,

- \(a\) = number of samples “Follow-up needed” for both systems,
- \(b\) = number of samples “Follow-up needed” for the BD OneFlow system but “No follow-up needed” for the EuroFlow system,
- \(c\) = number of samples “No follow-up needed” for the BD OneFlow system but “Follow-up needed” for the EuroFlow system, and
- \(d\) = number of samples “No follow-up needed” for both systems.

The results for all cell types are shown in Table 4.
Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.

The results for T cells are shown in Table 5.

**Table 5 Agreement for T cells being “Follow-up needed” or “No follow-up needed”**

<table>
<thead>
<tr>
<th>Comparator method (Euroflow LST cocktail)</th>
<th>Follow-up needed</th>
<th>No follow-up needed</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigational method (BD OneFlow LST)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Follow-up needed</td>
<td>35</td>
<td>0</td>
<td>35</td>
</tr>
<tr>
<td>No follow-up needed</td>
<td>0</td>
<td>172</td>
<td>172</td>
</tr>
<tr>
<td>Total</td>
<td>35</td>
<td>172</td>
<td>207</td>
</tr>
</tbody>
</table>

Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.
The results for B cells are shown in Table 6.

<table>
<thead>
<tr>
<th>Comparator method (Euroflow LST cocktail)</th>
<th>Follow-up needed</th>
<th>No follow-up needed</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigational method (BD OneFlow LST)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Follow-up needed</td>
<td>81</td>
<td>0</td>
<td>81</td>
</tr>
<tr>
<td>No follow-up needed</td>
<td>0</td>
<td>126</td>
<td>126</td>
</tr>
<tr>
<td>Total</td>
<td>81</td>
<td>126</td>
<td>207</td>
</tr>
</tbody>
</table>

Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.
The results for NK cells are shown in Table 7.

**Table 7 Agreement for NK cells being “Follow-up needed” or “No follow-up needed”**

<table>
<thead>
<tr>
<th>Comparator method (Euroflow LST cocktail)</th>
<th>Investigational method (BD OneFlow LST)</th>
<th>Follow-up needed</th>
<th>No follow-up needed</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Follow-up needed</td>
<td>6</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>No follow-up needed</td>
<td>0</td>
<td>201</td>
<td>201</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>6</td>
<td>201</td>
<td>207</td>
</tr>
</tbody>
</table>

a. NK cell malignancies are rare, therefore the expected number of samples is very low.

Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.

**Equivalency**

Peripheral blood, bone marrow, and lymph node specimens collected at 3 external clinical laboratories were obtained from patients with T-cell, B-cell, or NK-cell abnormalities, or with no hematological abnormalities. Specimens were analyzed using the BD OneFlow LST system and the EuroFlow LST system described previously.

The bias for leukocytes identified as being a percentage of SSC singlets is summarized in Table 8.

**Table 8 Summary of bias for Leukocytes (%SSC singlets)**

<table>
<thead>
<tr>
<th>Population</th>
<th>No. of samples</th>
<th>Average bias</th>
<th>Lower 95% CL of average bias</th>
<th>Upper 95% CL of average bias</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leukocytes (%SSC singlets)</td>
<td>207</td>
<td>-1.1%</td>
<td>-1.7%</td>
<td>-0.6%</td>
</tr>
</tbody>
</table>
The remaining eight cell populations were identified as being a percentage of the cell populations indicated in Table 9. Deming regression statistics indicate that the results obtained using the two systems are substantially equivalent.

Table 9 Equivalency of the BD OneFlow system to the EuroFlow system

<table>
<thead>
<tr>
<th>Population</th>
<th>No. of samples</th>
<th>Intercept</th>
<th>Slope</th>
<th>Lower 95% CL of slope</th>
<th>Upper 95% CL of slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lymphocytes (%Leukocytes)</td>
<td>207</td>
<td>-0.68</td>
<td>1.01</td>
<td>1.00</td>
<td>1.02</td>
</tr>
<tr>
<td>T cells (%Lymphocytes)</td>
<td>207</td>
<td>1.07</td>
<td>0.99</td>
<td>0.98</td>
<td>1.00</td>
</tr>
<tr>
<td>CD4+CD8– cells (%T cells)</td>
<td>207</td>
<td>-0.64</td>
<td>1.01</td>
<td>1.00</td>
<td>1.02</td>
</tr>
<tr>
<td>CD8+CD4– cells (%T cells)</td>
<td>207</td>
<td>-0.45</td>
<td>1.00</td>
<td>0.99</td>
<td>1.01</td>
</tr>
<tr>
<td>B cells (%Lymphocytes)</td>
<td>207</td>
<td>-0.01</td>
<td>1.00</td>
<td>0.99</td>
<td>1.00</td>
</tr>
<tr>
<td>NK cells (%Lymphocytes)</td>
<td>207</td>
<td>0.81</td>
<td>0.92</td>
<td>0.84</td>
<td>1.00</td>
</tr>
<tr>
<td>smIgκ+ cells (%B cells)</td>
<td>206a</td>
<td>2.24</td>
<td>1.00</td>
<td>0.97</td>
<td>1.02</td>
</tr>
<tr>
<td>smIgλ+ cells (%B cells)</td>
<td>206a</td>
<td>-2.04</td>
<td>1.00</td>
<td>0.98</td>
<td>1.03</td>
</tr>
</tbody>
</table>

a. One patient specimen had 0 and 2 B-cell events for the two systems, respectively. Since smIgκ and smIgλ are defined as a percentage of B-cell events in this study, they could not be defined in one system, and therefore could not be included in the quantitative analysis for smIgκ and smIgλ for that specimen.

11. LIMITATIONS

- Use of therapeutic monoclonal antibodies in patient treatment can interfere with recognition of target antigens by this reagent. This should be considered when analyzing samples from patients treated in this fashion. BD Biosciences has not characterized the effect of the presence of therapeutic antibodies on the performance of this reagent.
• Use of this reagent for diagnostic evaluation of hematologic disorders should be performed in the context of a thorough immunophenotypic analysis including other relevant markers.
• Use of heparin as an anticoagulant can result in dimmer staining for CD56 as compared to EDTA.
• Use of BD OneFlow LST requires experience with leukemia and lymphoma immunophenotyping and classification.

WARRANTY

Unless otherwise indicated in any applicable BD general conditions of sale for non-US customers, the following warranty applies to the purchase of these products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE QUANTITY AND CONTENTS STATED ON THE LABEL OR IN THE PRODUCT LABELING AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR PURPOSE AND NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF THE PRODUCTS OR REFUND OF THE PURCHASE PRICE. BD IS NOT LIABLE FOR PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING PERSONAL INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT.

TROUBLESHOOTING

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The resolution between debris and lymphocytes is poor.</td>
<td>Specimen was poorly lysed.</td>
<td>Prepare and stain another specimen.</td>
</tr>
<tr>
<td>Specimen is of poor quality.</td>
<td>Check cell viability.</td>
<td></td>
</tr>
<tr>
<td>Specimen is too old.</td>
<td>Obtain a new specimen and stain it immediately.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td>Staining is dim or fading.</td>
<td>Cell concentration was too high at the staining step.</td>
<td>Check the cell concentration and adjust as needed.</td>
</tr>
<tr>
<td>Washed specimen was not stained within 30 minutes of the last wash.</td>
<td></td>
<td>Repeat staining with a freshly prepared specimen.</td>
</tr>
<tr>
<td>BD OneFlow LST was exposed to light for too long.</td>
<td></td>
<td>Repeat staining with a new tube of BD OneFlow LST.</td>
</tr>
<tr>
<td>Stained cells were stored too long before acquiring them.</td>
<td></td>
<td>Repeat staining with a fresh specimen and acquire it promptly.</td>
</tr>
<tr>
<td>Few or no cells are recorded.</td>
<td>Cell concentration was too low.</td>
<td>Resuspend fresh specimen at a higher concentration. Repeat staining and acquisition.</td>
</tr>
<tr>
<td></td>
<td>Cytometer is malfunctioning.</td>
<td>Troubleshoot the instrument. See the cytometer IFU for more information.</td>
</tr>
<tr>
<td>Some of the dot plots are dimmed.</td>
<td>FSC-H and SSC-H were not selected when the application settings were created.</td>
<td>Check that FSC-H and SSC-H are selected on the Parameters tab of the Inspector.</td>
</tr>
<tr>
<td>The barcode on the BD OneFlow LST tube label cannot be scanned.</td>
<td>The barcode on the tube label has been compromised.</td>
<td>Scan the barcode on the BD OneFlow LST pouch label into the Product ID keyword field in the Experiment Layout. Next, after the last digit of the barcode, manually enter a semicolon (;) followed by the six-digit tube-specific ID, found adjacent to the barcode on the tube label.</td>
</tr>
<tr>
<td>Some of the keywords are missing from the statistics box in the analysis worksheet.</td>
<td>BD FACSDiva software did not import all of the keywords into the panel template.</td>
<td>1. Navigate to the analysis worksheet. 2. Right-click the statistics box and select Edit Stats View. 3. In the Header tab, select the All checkbox. 4. Click OK.</td>
</tr>
</tbody>
</table>
REFERENCES


---

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The statement, *For in vitro diagnostic use*, does not appear in the footer of the analysis worksheet when it is printed. | The paper margins in the printer settings were changed. | 1. From the BD FACSDiva software menu bar, select File > Page Setup.  
2. Ensure that all of the margins are set to 2.54 cm or 1 inch, depending on your default standards.  
3. Click OK. |


